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WIRELESS TELECOMMUNICATIONS BUREAU ANNOUNCES NEW PROCEDURES FOR 
FILING PART 22 PAGING APPLICATIONS IN UNIVERSAL LICENSING SYSTEM (ULS)

STARTING JUNE 1, 1998
Part 22 Paging Licensees Encouraged to Use New ULS Application Forms and Electronic Filing
Procedures as of June 1, 1998; Special Instructions Provided for Part 22 Paging Licensees Filing

Renewal Applications in June 1 - June 30, 1998 Filing Window

On June 1, 1998, the Wireless Telecommunications Bureau will commence use of the 
Universal Licensing System (ULS) for all licensing in the Part 22 Paging and Radiotelephone Service 
(Part 22 paging). 1 ULS is a new interactive licensing database that has been developed by the Bureau 
to consolidate and replace the eleven existing licensing systems that are currently used to process 
applications and grant licenses in wireless services. While ULS has previously been used to process 
long form applications following the 800 MHz SMR and LMDS auctions, this is the first instance in 
which an existing wireless service will be converted to ULS for application processing purposes. We 
encourage Part 22 paging licensees and applicants to take advantage of the many innovative features of 
the new system, although to ensure a smooth transition, licensees and applicants will continue to have 
the option of using current forms and manual filing procedures after the conversion to ULS. The 
Bureau plans to similarly convert other wireless services to ULS in the coming months, beginning with 
PCS later in June and cellular in July.

ULS will provide significant benefits for Part 22 paging licensees, applicants, and the public, 
including fast and easy electronic filing, improved data accuracy through automated checking of 
applications, and enhanced electronic access to licensing information. Specifically, the use of ULS 
will result in the following significant changes for Part 22 paging licensees and applicants:

  New ULS forms (Forms 601, 603, and 604) may be used for electronic filing of Part 22 
paging applications, modifications, notifications, and transfer and assignment requests. 2

  Part 22 paging licensees who are due to file renewal applications in the June 1 - June 30, 
1998 filing window will be able to file electronic renewal applications quickly and easily in 
ULS. This Public Notice provides detailed instructions for filing such applications 
electronically using Form 601.3

  Although we encourage use of the new ULS forms, Part 22 paging applicants and licensees 
may continue to file applications, renewals, modifications, notifications, and transfer and 
assignment requests manually on current forms (e.g., Forms 600, 490, 405).

1 See Part 22, Subpart E of the Commission's rules, 47 CFR § 22.500 et seq.

2 See Attachment A for instructions on electronic filing.

3 See Attachment B for specific instructions on electronic filing of Part 22 paging renewal applications.
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  In order to file applications and update licensing information in ULS, Part 22 paging 
licensees must register their Taxpayer Identification Numbers (TINs) and select a user 
password in ULS. For licensees who have not yet registered their TINs and selected a 
password, this Public Notice provides instructions for doing so.4

  All existing licensing data for this service, which has previously been contained in the 
Bureau's CLM database, will be transferred to the ULS database, and all Part 22 paging 
applications filed on or after June 1, 1998 will be entered into the ULS database and processed 
through ULS. As of June 1, 1998, the Part 22 paging licensing database will be available to 
the public through ULS.5 Licensing data regarding this service will no longer be updated in 
the CLM database.

The procedural changes announced in this Public Notice affect Part 22, Subpart E services. 
Application and processing procedures for other Part 22 services (Cellular, Offshore Radio, Rural 
Radio, BETRS, Air-Ground) and for Part 90 paging services (e.g., 929 MHz paging) are not affected. 
These and other wireless services will be converted to ULS at a later date. Information regarding such 
conversions will be provided by future public notice and will be posted on the Commission's ULS 
Internet home page (http://www.fcc.gov/wtb/uls).

The development of ULS is also the subject of a Notice of Proposed Rulemaking in WT 
Docket No. 98-20, adopted by the Commission on February 19, 1998.6 The ULS forms and 
procedures announced in this Public Notice are for interim purposes and are potentially subject to 
future modification based on the outcome of the ULS rulemaking. We encourage all interested parties 
to participate in the rulemaking so that we can continue to improve ULS and ensure its responsiveness 
to customer needs.

Form 601 Filing Procedures

For Part 22 paging applicants and licensees, FCC Form 601 (OMB Approval Number 3060- 
0798) will be available as of June 1, 1998, and may be used as of that date to file paging-related 
applications, amendments, modifications, and requests for special temporary authority (STAs). 7 Form 
601 may also be used to request a waiver or extension of time in conjunction with a paging 
application or license. Form 601 may also be used in lieu of Form 405 for renewal applications (see 
instructions below) and Form 489 for notifications.

Applicants are encouraged to file Form 601 electronically. Therefore, in order to immediately 
bring the full benefits of online filing to the public, the Bureau hereby waives the requirements of 
Section 22.105 of the Commission's rules, 47 C.F.R. § 22.105, to the extent that it requires filing of 
Forms 405, 489, or 600 by Part 22 paging applicants. This waiver is conditioned on the timely filing 
of a Form 601 in lieu of one of the above forms. For instructions on registering in ULS and filing 
Form 601 electronically, see Attachment A. Applicants may also file Form 601 manually. For

4 See Attachment A for instructions on TIN registration.

5 See Attachment C for instructions on searching for application and license information in ULS.

6 Amendment of Parts 0, 1, 12, 22, 24, 26, 27, 80, 87, 90, 95, 97, and 101 of the Commission's Rules to 
Facilitate the Development and Use of the Universal Licensing System in the Wireless Telecommunications Services, 
Notice of Proposed Rulemaking, WT Docket No. 98-20, FCC 98-20 (adopted February 19, 1998; released March 
18, 1998 (ULSNPRM).

7 Paging applicants filing applications before June 1, 1998 should not use Form 601.
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instructions on manual filing, see Attachment D. All paging applicants and licensees must register 
their TINs in ULS (see below) and submit them with their applications regardless of whether they file 
electronically or manually.

Applicants and licensees are advised that the conversion of Part 22 paging to ULS does not 
affect existing restrictions on filing of initial paging applications in anticipation of the upcoming 
auction of Part 22 paging channels. 8 Applications that fail to comply with these restrictions will be 
dismissed. Filing dates and procedures for the paging auction will be announced by future public 
notice.

Online Renewal Procedures For Paging Licensees Filing Renewal Applications In June 1 - June 
30. 1998 Filing Window

Based on the expiration dates contained in our licensing database, the Bureau anticipates 
receiving approximately 2,000 paging renewal applications between June 1 and June 30, 1998. These 
renewal applications may be filed electronically in ULS, and the Bureau encourages licensees to take 
advantage of this process. Licensees are reminded that renewal applications may be filed only during 
the final 30 days of the license term. Early or late-filed renewals will be dismissed as defective 
pursuant to 47 C.F.R. § 22.128(f). Only those licenses with an expiration date of July 1, 1998, may 
be renewed during the June window.

Online renewal in ULS can be accomplished in a few easy steps. See Attachment B for 
specific instructions on filing renewal applications online.

Transfer and Assignment Applications

For Part 22 paging applicants and licensees, FCC Form 603 (Application for Assignment of 
Authorization, OMB Approval Number 3060-0800) and Form 604 (Application for Transfer of 
Control, OMB Approval Number 3060-0797) will be available as of June 1, 1998, and may be used as 
of that date in lieu of Form 490 to file applications for assignment of license or transfer of control, 
respectively.9 Accordingly, the Bureau hereby waives the requirements of Section 22.105 of the 
Commission's rules, 47 C.F.R. § 22.105, to the extent that it requires filing of Form 489 by Part 22 
paging licensees seeking approval of assignments or transfers. This waiver is conditioned on the 
timely filing of Form 603 or 604, as appropriate, in lieu of Form 490. Forms 603 and 604 may be 
filed electronically or manually. For instructions on electronic filing, see Attachment A. For 
instructions on manual filing, see Attachment D.

Part 22 paging licensees who are filing notifications of pro forma assignments or transfers 
pursuant to the Commission's recent forbearance order may continue to use the letter notification 
procedures described in that order 10 In addition, starting June 1, 1998, licensees may provide such 
notification by filing Form 603 or 604, as appropriate, within 30 days of consummation of the pro

8 See Revision of Part 22 and Part 90 of the Commission's Rules to Facilitate Future Development of Paging 
Systems, First Report and Order, WT Docket No. 96-18, 11 FCC Red 16570 (1996).

' Paging applicants filing assignment or transfer applications before June 1, 1998 should use Form 490.

10 Federal Communications Bar Association's Petition for Forbearance from Section 310(d) of the 
Communications Act Regarding Non-Substantial Assignments of Wireless Licenses and Transfers of Control 
Involving Telecommunications Carriers, Memorandum Opinion and Order, FCC 98-18 (adopted February 4, 1998; 
released February 4, 1998).
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forma assignment or transfer. Whether notification is by form or by letter, no fee will be required 
for submission of such notification.

Beginning June 1, Part 22 paging licensees filing applications for partial assignments (e.g., 
application to assign some but not all sites associated with a call sign) must submit an attachment 
describing the details of the partial assignment. This description must contain all information 
necessary to completely describe the proposed partial assignment (e.g., call sign(s), location(s), and 
frequency(s)). This requirement to file an attachment is temporary. We will issue a public notice 
when partial assignment information can be directly entered into ULS.

In the event that a transfer or assignment transaction involves both Part 22 paging licenses and 
licenses in other wireless services that have not yet been converted to ULS, the applicant will need to 
file separate applications for the Part 22 paging and non-ULS-based licenses, with the non-ULS 
application(s) filed on existing forms." This requirement is temporary until the databases for all 
wireless services have been converted to ULS. In the interim, applicants who file Part 22 paging 
transfer and assignment applications in ULS and non-ULS applications for a common transfer or 
assignment transaction are encouraged to contact the Bureau's Commercial Wireless Division (202- 
418-0620) ahead of time to coordinate the application and approval process.

Under Section 22.137(a) of the Commission's rules, 47 CFR § 22.137(a), an assignee or 
transferee of a Part 22 license must file a report qualifying it as a common carrier (FCC Form 430) 
unless a current report is already on file with the Commission. The Commission has proposed to 
replace Form 430 with new ULS Form 602 for collection of ownership information. 12 However, Form 
602 is still in development and is not currently available. Therefore, assignees and transferees of Part 
22 paging licenses should continue to file Form 430 in accordance with Section 22.137(a) until further 
notice.

TIN Registration

As mandated by the Debt Collection Improvement Act of 1996, the Commission has required 
existing wireless licensees, including Part 22 paging licensees, to register their Taxpayer Identification 
Numbers in ULS, and most licensees have completed this process. 13 If you are a Part 22 licensee who 
has not yet registered your TIN in ULS, you must do so before you can file applications or update 
licensing information in ULS. This applies whether or not you are filing electronically using ULS 
forms or are filing pre-ULS forms manually. To protect licensee privacy, registered TINs will not be 
made available to the public. However, TIN information may be released to the U.S. Treasury 
Department for purposes of compliance with the Debt Collection Act.

You may register your TIN electronically in ULS by going to the FCC's Internet site at 
"http://www.fcc.gov/wtb/uls" and clicking on the "ULS Call Sign Registration" link. Detailed 
instructions for electronic filing are set forth in Attachment A. If you choose to file your TIN 
registration manually, FCC Form 606 (TIN Registration Form) can be obtained from the Internet at 
http://www.fcc.gov/formpage.html, by calling the FCC's Form Distribution Center at 1-800-418-FORM

" For example, a licensee seeking to assign Part 22 paging licenses and cellular licenses may use Form 603 
for the paging licenses, but must file Form 490 for the cellular licenses because cellular has not yet been converted 
to ULS. Similarly, a licensee seeking to assign point-to-point microwave licenses must use Form 702.

12 ULS NPRM, para. 45.

13 See "Wireless Telecommunications Bureau Universal Licensing System Registration Now Available," Public 
Notice, November 4, 1997.
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(3676), or from the FCC's Fax-on-Demand service by calling (202) 418-0177 from the handset of a 
fax machine (follow the prompts and use document retrieval number 000606). The completed Form 
606 should be mailed to:

Federal Communications Commission 
Information Technology Division 
Attention: Department CD 
1270 Fan-field Road 
Gettysburg, PA 17325-7245

Continued Use of Pre-ULS Application Forms

The Bureau encourages paging applicants to immediately begin taking advantage of the speed 
and ease in filing offered by ULS. However, in order to provide a smooth transition to ULS, the 
Bureau will continue to accept manually-filed applications from Part 22 paging licensees and 
applicants on FCC Forms 600, 490, 489, and 405, as well as informal letter requests. No decision on 
the phasing out of these forms will be made until the adoption of an order in the ULS rulemaking 
proceeding. During this transition period, we remind applicants using non-ULS forms they they must 
include their TIN on the application so that the data can be entered into ULS.

Application Fees

Applicants using ULS to file electronically remain subject to existing application fees where 
applicable under current rules. ULS, however, will simplify the process of submitting fees to the 
Commission and greatly reduce the potential for insufficient fees to be submitted. When an applicant 
submits its application online, ULS will assign a file number and will pre-fill fee information on FCC 
Form 159, including the correct fee amount due and the payment type code. ULS will then allow the 
applicant to print a copy of the application as submitted, and instruct the applicant on how to print out 
the pre-filled Form 159 so that it can be mailed to Mellon Bank. ULS will instruct the applicant to 
mail the Form 159 and fee to the appropriate Mellon Bank address. The Form 159 and accompanying 
fee must be received by Mellon within 5 business days of filing the application. In the near future, 
ULS will be capable of accepting credit card payments online. The Bureau will release a public notice 
and provide information on its website when this option becomes available.

Section 1.1111 of the Commission's Rules, 47 C.F.R. § 1.1111, requires applications and fees 
to be submitted as a single package and states that the Commission will be responsible for matching 
fees and applications submitted separately. In the ULS NPRM, the Commission proposed to amend 
this requirement to provide for the filing of applications online and fees separately, via mail. In order 
to immediately bring the full benefits of online filing to the public, the Bureau hereby waives the 
requirements of Section 1.1111 to the extent that Part 22 applicants filing electronically via ULS may 
remit fees separately via U.S. mail or courier. This waiver is conditioned on the appropriate fee 
amount being received at Mellon Bank, at the address specified to the applicant by the ULS, within 5 
business days from the receipt date shown on the application. Applications filed online that do not 
conform with the conditions of this waiver will be dismissed as defective.

Data Corrections to 929/931 MHz Paging Database

On April 9, 1998, the Bureau released a Public Notice (Database Correction Public Notice) 
instructing incumbent 929 MHz and 931 MHz band commercial and private carrier paging licensees to
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examine the Commission's licensing records and submit corrections if the records are in error. 14 This 
action was requested in preparation for the 929/931 MHz Paging auction tentatively scheduled for later 
this year, and to ensure that the paging database is as accurate as possible when it is converted to the 
ULS. The Database Correction Public Notice provided specific information that should be included in 
requests for correction, and set forth addresses where licensees should submit the requests. The 
transfer of 931 MHz paging data to ULS on June 1 will not alter the content of the requests, the 
deadlines for submitting requests, or the addresses where they should be submitted. It-will however, 
change the procedure by which 931 MHz licensees may review our database online to ensure that 
corrections have been made. For further information on 931 MHz licensees should point their web 
browsers to http://www.fcc.gov/wtb/cpgncrct.html for instructions on how to review the ULS database.

Please note that nothing in this Public Notice changes procedures for 929 MHz paging licensees. 

For Further Information or Assistance

For general information about ULS, and for answers to frequently asked questions regarding 
submitting applications, remitting fees, finding the status of pending applications, and searching the 
ULS database, we recommend that you first consult the ULS webpage at http://www.fcc.gov/wtb/uls. 
Those having specific questions that are not addressed on the webpage may contact Commission staff 
via phone or e-mail as described below.

FCC Technical Support Headline -- (202) 414-1250. Contact Technical Support if you have questions 
about accessing ULS from your computer, registering your TIN, uploading files, or submitting 
attachments in ULS. The FCC Technical Support Headline is available Monday through Friday, from 
9 a.m. to 6 p.m. ET. In order to provide better service to ULS users and ensure the security of the 
electronic filing system, all calls to the FCC Technical Support Headline are recorded.

ULS Licensing Support - Beginning June 1, 1998, (202) 418-7ULS (418-7857) or via e-mail at 
bwoodwar@fcc.gov. Contact Licensing Support if you have questions about which application 
purpose(s) are appropriate for a particular filing, what information is being requested on a ULS Form 
or Schedule, or any other licensing matter related to ULS. ULS Licensing Support will be available 
Monday through Friday, from 8:30 a.m. to 4 p.m. ET.

14 "Wireless Telecommunications Bureau Makes 929 MHz and 931 MHz Paging Databases Available for 
Review Prior to Auction," Public Notice, DA 98-684, April 9, 1998.
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Note: The TIN provided must be that of the licensee and not of an agent or 
representative of the licensee (e.g., law firm or consultant).

6. Complete the registration form. Click the Help button at anytime for additional 
information on completing the online registration form.

7. Specify the password and personal or corporate identifier that you will use in
conjunction with your TIN. In the New Password field, enter a password of at least 5 
characters.

Basic guidelines for selecting your self-assigned password:

  Specify a password that you will be able to remember easily. For security
purposes, avoid selecting an obvious password that someone else could easily 
guess, such as spouse's name, child's name, etc.

  Your password must be at least 5 characters but no more than 30 characters.

  You may use letters, numbers, or symbols in your password.

  Write down your password and keep it in a secure place.

  Note that your password is case sensitive. For example, if you specify
"station" (lowercase) as your password, you must always enter "station" in 
lowercase during ULS login. "Station" or "STATION" will not be accepted.

8. Re-enter your password in the Verify Password field. This entry must be an exact 
replication of the password entered in the New Password field.

9. In the Personal Identifier or Corporate Identifier field, enter a word (of your choice) 
to serve as your personal identifier (if individual) or corporate identifier (if business 
entity).

Note: For security purposes, you -will be required to correctly enter your TIN and 
password prior to accessing the ULS for filing applications online or updating your 
registration information. If you forget your password, contact FCC Technical Support 
at (202) 414-1250. The FCC support staff will ask for your personal or corporate 
identifier to verify your identity before resetting your password.

10. When you have completed the registration form, click the Submit button.

If you have entered any incomplete or erroneous information, an Errors screen lists the 
errors. Click Return, make your corrections, then click Submit again. Note that an 
application cannot be submitted until all errors have been corrected.

1752



11. A screen appears requesting you to identify the call signs (if any) to be associated
with your TIN. Even though you already have FCC licenses, you must identify to the 
ULS the call signs that are to be associated with your TIN. Then, in subsequent 
online filing sessions, the ULS will recognize your TIN and authorize you to update 
the license information and file for renewal of the call signs you registered with the 
ULS. The ULS will not permit you to update license information or file for renewal 
unless you have registered your call signs with the ULS.

12. Follow the instructions on the screen to select a call sign entry method. Note: You 
must use the Upload Call Signs option if you have more than 100 call signs.

Click the Help button for additional call sign entry instructions.

13. After entering your call signs, click the Submit button.

14. When your registration has been successfully submitted to the FCC, a confirmation 
message screen appears. This screen shows the TIN, password, and personal or 
corporate identifier that you just registered.

Important: Your registration has not been successfully submitted to the ULS unless 
this confirmation screen appears.

15. From the confirmation screen, click the Home button to return to the ULS home page.

Filing FCC Forms 601. 603, and 604 Electronically

After the applicant's TIN is registered with the FCC, the FCC Form 601, 603, and 604 can be 
filed electronically. Do the following:

1. Connect to the FCC Network using Dial-Up Networking in Windows 95 or the FCC- 
supplied PPP Dialer in Windows 3.1x.

2. Start your web browser. In the Location field (Netscape 3.x), Netsite field (Netscape 
4.x), or Address field (Internet Explorer) of the web browser screen, type 
http://wtbwww05.fcc.gov. Then press the ENTER key. This will access the Universal 
Licensing System home page.

3. Click the Online Filing button.

4. On the ULS Online Filing screen, click Log into ULS Online Filing System to select 
it, then click the Continue button.
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5. On the login screen, type your Taxpayer Identification Number (TIN) in the login 
field.

6. In the Password field, type the password you selected during TIN registration.

This field is case sensitive; be sure to type the password exactly as you specified it 
when you registered with the FCC. For example, if you registered with the password 
PASSWD, do not type passwd.

7. Click the Continue button. '
i

If you entered an incorrect TIN and/or password, an error message appears. You must 
then type the correct information and click Continue again. (If you have not yet 
registered your TIN with the FCC, you must do so before filing.)

8. After you have entered your TIN and password correctly, one of the following screens 
appears:

  If you have existing incomplete applications or completed applications filed 
this business day, an intermediate screen appears listing these applications. 
You may finish an incomplete application or modify a completed application 
by clicking on it. Once the application is opened, follow the basic guidelines 
for filing provided below. To create a new application to submit, click the 
Select New Filing.

  If you do not have existing incomplete applications or completed applications 
filed this business day, a screen appears requesting you to select an application 
purpose.

9. Click the down-arrow burton at the end of the Purpose of Application field to obtain 
the drop-down menu, and click on the purpose of filing (e.g., Renewal Only, Transfer 
of Control, Modification, etc.)

10. Click the Continue button. The ULS screens will step you through the filing process 
specific to your purpose of application. Basic guidelines for filing each form are 
provided below. Refer to Attachment B for specific instructions for filing for Renewal 
applications.

Click the ? (Help) button at any time for specific filing instructions for each 
application purpose.

Basic Guidelines for Filing Form 601 (excluding Modifications) Online:

  Some of the data entry fields on the online application form may be pre-filled 
with information from the TIN registration process.
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  The online application consists of data entry fields as well as "yes or no" 
questions. You must respond to all of the "yes or no" questions on the 
application. If you respond Yes to a question, you may be required to file an 
attachment explaining the specific circumstances (see form for specific 
instructions).

• An Attachments button is provided for uploading attachment files. You are 
responsible for filing all required attachments.

  If you have entered any incomplete or erroneous information, an Errors screen 
lists the errors. Click Return, make your corrections, then click Continue 
again. The system does not allow you to proceed to the next page in the 
application until you correct all errors. However, you can Save your application 
and complete it at a later date, if necessary. Saved applications must be 
completed within 30 days.

  If you are filing Form 601 for a Modification, refer to "Basic Guidelines for 
Filing Forms 603, 604, and Modifications Online" below.

Basic Guidelines for Filing Forms 603, 604, and Modifications Online:

• You must use Netscape Communicator 4.05 with JDK 1.1 support to file Forms 
603 and 604. You can download Netscape Communicator 4.05 with JDK 1.1 
free of charge at http://www.netscape.com/download.

  Java and JavaScript must be enabled in your web browser preferences to file
Forms 603 and 604. To enable Java and JavaScript in Netscape Communicator 
4.05, click the Edit menu heading and select Preferences. In the Category 
section, click Advanced. Verify that both Enable Java and Enable JavaScript 
are checked.

  The online application contains several pages, each represented by a tab at the 
top of the electronic form.

  To fill out the application, complete each page separately. After you complete a 
page, click on the Next button at the bottom of the screen. If you did not enter 
data into required fields, an error message appears identifying the missing data. 
Click on Return to go back to the page, correct your information, and click 
Continue again.. The system does not allow you to proceed to the next page in 
the application until you correct all errors. However, you can Save your 
application and complete it at a later date, if necessary. Saved applications 
must be completed within 30 days.

  To view a completed page, use the Previous button to page back through
completed pages of the application or click on its tab at the top of the screen.
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  The online application consists of data entry fields as well as "yes or no" 
questions. You must respond to all of the "yes or no" questions on the 
application. If you respond Yes to a question, you may be required to file an 
attachment explaining the specific circumstances (see form for specific 
instructions).

• An Attachments button is provided for uploading attachment files. You are 
responsible for filing all required attachments.

11. When your application has been successfully submitted to the FCC, a confirmation 
message screen appears. This screens shows a file number for the application, the 
payment type code, and the fee amount (if applicable). You may print the screen and 
use this information when completing FCC Remittance Advice, FCC Form 159. The 
FCC Form 159 must be mailed or delivered, along with appropriate payment to:

Federal Communications Commission 
Common Carrier Land Mobile 
P. O. Box 358130 
Pittsburg, PA 15251-5130

Important: Your application has not been successfully submitted to the FCC unless 
you have received a file number assigned by the Universal Licensing System.

12. To print a copy of the submitted application:

a. Click the Print Preview button to see the formatted version of the application.

Note that the file number is at the top of the form. If there is no file number 
present, this application has not been successfully submitted to the FCC.

b. Print the application by clicking your browser's Print button.

c. To return to the confirmation screen, click your browser's Back button.

13. From the confirmation screen, you can click the Home button to return to the ULS 
home page or the Online Filing Menu button if you wish to submit another 
application.

Technical Support

For technical assistance in registering or filing the FCC Forms 601, 603, and 604 
electronically, contact the FCC Technical Support Hotline at (202) 414-1250. The FCC 
Technical Support Hotline generally will be available Monday through Friday, from 8 a.m. to 
6 p.m. ET. All calls to the FCC Technical Support Hotline are recorded.
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Attachment B

INSTRUCTIONS FOR FILING FOR RENEWAL OF A LICENSE 
IN THE PAGING SERVICE

Following are instructions for electronically filing applications for license renewal. Only 
those licenses with an expiration date of July 1, 1998, may be renewed during the month of 
June 1998.

To use the Universal Licensing System (ULS) to electronically file for license renewal, you 
must first connect to the FCC Network. Note the following:

o Attachment E describes how Windows 95 users can connect to the FCC Network 
using the Dial-Up Networking features of Windows 95.

o Attachment F describes how Windows 3.1 and Windows for Workgroups 3.11 users 
can connect to the FCC Network using a PPP Dialer application that is available for 
downloading.

Conventions

The instructions in this attachment use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer,
including buttons, Internet links, icon, tabs, menu items (e.g., Cancel button, 
Auctions link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Licensee Name field, 
Applicant Information area of a screen).

bold italic Represents characters that you must type exactly as they appear in the
instructions. For example, if you are instructed to type http://www.fcc.gov, you 
should type all of the characters shown in bold italic exactly as they are 
printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, Esc).
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Filing for License Renewal Electronically

Before using ULS to file for license renewal, the applicant's Taxpayer Identification Number 
(TIN) and call signs must be registered with the FCC's Universal Licensing System (ULS). 
If you have not registered your TIN and call signs with the ULS, refer to the "Registering 
TIN and Call Signs with the FCC Electronically" instructions in Attachment A.

After the applicant's TIN and call signs are registered with the FCC, the FCC Form 601, 603, 
and 604 can be filed electronically. Do the following:

1. Connect to the FCC Network using Dial-Up Networking in Windows 95 or the FCC- 
supplied PPP Dialer in Windows 3.1x.

2. Start your web browser. In the Location field (Netscape 3.x), Netsite field (Netscape 
4.x), or Address field (Internet Explorer) of the web browser screen, type 
http://wtbwww05.fcc.gov. Then press the ENTER key. This will access the Universal 
Licensing System home page.

Note: You must have Java and JavaScript enabled in your web browser preferences. 
Refer to your web browser Help facility for more information.

3. Click the Online Filing burton.

4. On the ULS Online Filing screen, click Log into ULS Online Filing System to select 
it, then click the Continue button.

5. On the login screen, type your Taxpayer Identification Number (TIN) in the login
field. This field requires the TIN of the applicant. Do not type the TIN of the Real 
Party in Interest (if one exists).

6. In the Password field, type the password you selected during TIN registration.

This field is case sensitive; be sure to type the password exactly as you specified it 
when you registered with the FCC. For example, if you registered with the password 
PASSWD, do not type passwd.

1. Click the Continue button.

If you entered an incorrect TIN and/or password, an error message appears. You must 
then type the correct information and click Continue again. (If you have not yet 
registered your TIN with the FCC, you must do so before filing for license renewal.)

8. After you have entered your TIN and password correctly, one of the following screens 
appears:
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  If you have existing incomplete applications or completed applications filed 
this business day, an intermediate screen appears listing these applications. 
You may finish an incomplete application or modify a completed application 
by clicking on it. Once the application is opened, follow the basic guidelines 
for filing provided below. To create a new application to submit, click the 
Select New Filing.

  If you do not have existing incomplete applications or completed applications 
filed that day, a screen appears requesting you to select an application purpose.

9. Click the down-arrow button at the end of the Purpose of Application field to obtain 
the drop-down menu, and click the Renewal Only entry in this menu.

10. Click the Continue burton.

11. A screen appears listing all of the licenses for the TIN that are available for renewal in 
this filing. A check box is located on the right side of each license in the list. Follow 
the guidelines below to select licenses for renewal:

Guidelines for Selecting Licenses for Renewal:

• To select a license for renewal, click on the corresponding check box. A check 
mark appears in the check box, indicating that the license is selected.

  To deselect a market, click again on the check box. The check mark 
disappears.

  Click on the Select All button to select all of the licenses listed on the Renewal 
screen. A check mark appears in each license's check box.

  Click on the Deselect All button to deselect all of the licenses listed on the 
Renewal screen. The check mark disappears.

12. Review the certification statements and sign the application by typing the first name, 
middle initial (if desired), last name, and title of the party authorized to sign the 
application. Like signing a paper application, your electronic signature certifies that 
all information provided on the application is true and correct and that you are in 
compliance with all of the General Certification Statements.

13. Click the Renew button.

14. When your application has been successfully submitted to the FCC, a confirmation 
message screen appears. This screens shows a file number for the application, the 
payment type code, and the fee amount (if applicable). You may print the screen and
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Attachment A

INSTRUCTIONS FOR REGISTERING TIN AND CALL SIGNS WITH FCC 
AND FILING FCC FORMS 601, 603, AND 604 ELECTRONICALLY

Following are instructions for electronically registering a Taxpayer Identification Number 
(TIN) and call signs with the FCC and electronically filing FCC Forms 601, 603, and 604.

To perform either of these procedures, you must first connect to the FCC Network as follows:

  Attachment E describes how Windows 95 users can connect to the FCC Network 
using the Dial-Up Networking features of Windows 95.

  Attachment F describes how Windows 3.1 and Windows for Workgroups 3.11 users 
can connect to the FCC Network using a PPP Dialer application that is available for 
downloading.

You also need Internet Web Browser software to electronically register and file FCC Form 
601. Netscape Communicator 4.05 with JDK 1.1, Netscape Navigator 3.01, and Microsoft 
Internet Explorer 3.02 with the file upload patch were used during FCC internal testing.

Important: You must use Netscape Communicator 4.05 with JDK 1.1 to file Forms 603, 
604, and Modifications or Renewal/Modifications on Form 601. Download Netscape 
Communicator 4.05 with JDK 1.1 free of charge at http://www.netscape.com/download.

Conventions

The instructions in this attachment use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer,
including buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, 
Auctions link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Licensee Name field, 
Applicant Information area of a screen).

bold italic Represents characters that you must type exactly as they appear in the
instructions. For example, if you are instructed to type http://www.fcc.gov, you 
should type all of the characters shown in bold italic exactly as they are 
printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, Esc).
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Registering TIN and Call Signs with the FCC Electronically

Before filing FCC Forms 601, 603, and 604, the applicant's Taxpayer Identification Number 
(TIN) and call signs must be registered with the FCC's Universal Licensing System (ULS). 
If you have already registered your TIN and call signs with the ULS, proceed to the "Filing 
FCC Forms 601, 603, and 604 Electronically" instructions.

To register a TIN and its associated call signs, do the following:

1. Connect to the FCC Network using one of the following options:

Note: If your PC is connected to a network, you must use a secure proxy to access 
the FCC Network. Consult your Network Administrator.

Dig I-Up Access

a. Use Dial-Up Networking in Windows 95 or the FCC-supplied PPP Dialer in 
Windows 3.1x.

b. Start your web browser. In the Location field (Netscape 3.x), Netsite field
(Netscape 4.x), or Address field (Internet Explorer) of the web browser screen, 
type http://wtbwwwOS.fcc.gov. Then press the ENTER key.

Internet Access

a. Start your web browser and connect to the Internet using your Internet Service 
Provider.

b. In the Location field (Netscape 3.x), Netsite field (Netscape 4.x), or Address 
field (Internet Explorer) of the web browser screen, type 
http://www.fcc.gov/wtb/uls. Then press the ENTER key.

2. Verify that Java and JavaScript are enabled in your web browser preferences. Refer to 
your web browser Help facility for more information.

3. Once you have accessed the Universal Licensing System home page, click the ULS 
Call Sign Registration button.

4. On the ULS TIN/Call Sign Registration screen, click Register Now to select it, then 
click the Continue button.

5. On the next screen, identify whether you are registering as a business entity (e.g.,
corporation, partnership, government entity, etc.) or an individual. Click the desired 
option to select it, then click the Continue button to access the registration form.
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use this information when completing FCC Remittance Advice, FCC Form 159. The 
FCC Form 159 must be mailed or delivered, along with appropriate payment to:

Federal Communications Commission 
Common Carrier Land Mobile 
P. O. Box 358130 
Pittsburg, PA 15251-5130

»

Important: Your application has not been successfully submitted to the FCC unless 
you have received a file number assigned by the Universal Licensing System.

15. To print a copy of the submitted application:

a. Click the Print Preview button to see the formatted version of the application.

Note that the file number is at the top of the form. If there is no file number 
present, this application has not been successfully submitted to the FCC.

b. Print the application by clicking your browser's Print button.

c. To return to the confirmation screen, click your browser's Back button.

16. From the confirmation screen, you can click the Home button to return to the ULS 
home page or the Online Filing Menu button if you wish to submit another 
application.

Technical Support

For technical assistance in using ULS to file license renewal applications, contact the FCC 
Technical Support Hotline at (202) 414-1250. The FCC Technical Support Hotline generally 
will be available Monday through Friday, from 8 a.m. to 6 p.m. ET. All calls to the FCC 
Technical Support Hotline are recorded.
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Attachment C

INSTRUCTIONS FOR SEARCHING FOR 
APPLICATIONS AND LICENSES

Following are instructions for electronically searching the FCC Network for specific 
applications or licenses with the Commission.

To search the FCC Network for an application, you must first connect to the FCC Network. 
Note the following:

o Attachment E describes how Windows 95 users can connect to the FCC Network 
using the Dial-Up Networking features of Windows 95.

o Attachment F describes how Windows 3.1 and Windows for Workgroups 3.11 users 
can connect to the FCC Network using a PPP Dialer application that is available for 
downloading.

Conventions

The instructions in this attachment use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer,
including buttons, Internet links, icon, tabs, menu items (e.g., Cancel button, 
Auctions link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Licensee Name field, 
Applicant Information area of a screen).

bold italic Represents characters that you must type exactly as they appear in the
instructions. For example, if you are instructed to type http://www.fcc.gov, you 
should type all of the characters shown in bold italic exactly as they are 
printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, Esc).
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Performing an Application Search

Once you have connected to the FCC Network, follow the procedures below to search for an 
application. You may click the ? (Help) button at anytime for additional information on using 
Application Search.

1. In the Location field (Netscape 3.x), Netsite field (Netscape 4.x), or Address field 
(Internet Explorer) of the web browser screen, type http://wtbwww05.fcc.gov. Then 
press the ENTER key. This will access the Universal Licensing System home page.

Note: You must have Java and JavaScript enabled in your \veb browser preferences 
to use Application Search. Refer to your web browser Help facility for more 
information.

2. On the Universal Licensing System main page, click the Application Search button, 
located on the left side of the page. The Application Search screen appears. This 
screen contains several data entry fields used for specifying search criteria.

Note: Application Search utilizes "cookies". If you are receiving a notification 
message when accepting a cookie, we recommend that you disable this message in 
your web browser options. Please consult your web browser Help facility for more 
information.

3. On the Application Search screen, specify the search criteria necessary to locate the 
desired application. Please refer to the following "Basic Guidelines for Specifying 
Search Criteria" for more information.

Basic Guidelines for Specifying Search Criteria:

You must specify search criteria in at least one field. You do not have to 
specify search criteria in all of the search fields. Enter search criteria into as 
many fields as you wish.

To specify search criteria in a search field containing a menu of options, click 
the desired option from the menu. Use the scroll bars to view all options in a 
menu. You can select multiple options from a menu by pressing the CTRL key 
while you click the menu options.

Click <No Criteria> to undo a menu selection and search for all options in the 
menu.

Click the Reset burton to clear entries from all of the search fields.
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The Universal Licensing System restricts the number of rows returned in an 
application search to 1000. In such instances, you must enter more specific 
search criteria to reduce the number of rows returned.

Click the ? (Help) button for a definition of each search field available on the 
Application Search screen.

4. After you have specified the desired search criteria, click the Search button. The
system will scan the database for any applications matching the search criteria. The 
matching application files will be listed on the Search Results screen. The Search 
Results screen will identify the file number, licensee name, application purpose, 
application status, radio service code, and receipt date for each application returned in 
the query.

A message on the Search Results screen will indicate if no matches were found for the 
specified search criteria. Click the New Search button and respecify search criteria.

5. To view an application, click its file number link. To navigate through the data on the 
Application screen, use the scroll bar or click the links at the top of the screen. Click 
the ? (Help) button for information regarding specific functions available on this 
screen.

To re-access the Search Results screen, click the down arrow at the end of the 
Other Options field to obtain the drop-down menu of options. Click Search 
Results from the Other Options menu and then click the Go button.

To begin a new search, click the down arrow at the end of the Other Options 
field to obtain the drop-down menu of options. Click New Search and then 
click the Go button.

Performing a License Search

Once you have connected to the FCC Network, follow the procedures below to search for a 
license. You may click the ? (Help) button at anytime for additional information on using 
License Search.

1. In the Location field (Netscape 3.x), Netsite field (Netscape 4.x), or Address field 
(Internet Explorer) of the web browser screen, type http://wtbwww05.fcc.gov. Then 
press the ENTER key. This will access the Universal Licensing System home page.

Note: You must have Java and JavaScript enabled in your web browser preferences 
to use License Search. Refer to your web browser Help facility for more information.
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2. On the Universal Licensing System main page, click the License Search button, 
located on the left side of the page.

Note: License Search utilizes "cookies". If you are receiving a notification message 
•when accepting a cookie, we recommend that you disable this message in your web 
browser options. Please consult your web browser Help facility for more information.

3. Select the type of search by clicking the down arrow in the Select Search Type field to 
obtain a menu containing the following options:

Select General to search for all licenses

Select Market Based to search only for market-based licenses

Select Site Based to search only for site-based licenses (use this search type 
when searching for Paging licenses)

Click the desired option from the menu and click the Continue button.

4. The License Search screen appears. This screen contains several data entry fields used 
for specifying the criteria for your license search. On the License Search screen, 
specify the search criteria necessary to locate the desired license. Please refer to the 
following "Basic Guidelines for Specifying Search Criteria" for more information.

Basic Guidelines for Specifying Search Criteria:

You must specify search criteria in at least one field. You do not have to 
specify search criteria in all of the search fields. Enter search criteria in as 
many fields as you wish.

To specify search criteria in a search field containing a menu of options, click 
the desired option from the menu. Use the scroll bars to view all options in a 
menu. You can select multiple options from a menu by pressing the CTRL key 
while you click the menu options.

Click <No Criteria> to undo a menu selection and search for all options in the 
menu.

Click the Reset button to clear entries from all of the search fields.
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The Universal Licensing System restricts the number of rows returned in a 
license search to 1000. In such instances, you must enter more specific search 
criteria to reduce the number of rows returned.

Click the ? (Help) button for a definition of each search field available on the License 
Search screen.

5. After you have specified the desired search criteria, click the Search button. The 
system will scan the database for any licenses matching the search criteria. The 
matching license files will be listed on the Search Results screen. The Search Results 
screen will identify the call sign, licensee name, radio service code, market, and 
licensee id for each license returned in the query.

A message on the Search Results screen will indicate if no matches were found for the 
specified search criteria. Click the New Search button and respecify search criteria.

6. To view a license, click its call sign underlined link. To navigate through the data on 
the License screen, use the scroll bar or click the links at the top of the screen. Click 
the ? (Help) button for information regarding specific functions available on this 
screen.

To re-access the Search Results screen, click the down arrow in the Other 
Options field to obtain the drop-down menu of options. Click Search Results 
from the Other Options menu and then click the Go button.

To access additional information about the license (such as special conditions, 
associated applications, and locations), click the down arrow in the License 
Options field to obtain the drop-down menu of options. Click the desired 
selection from the menu then click the Go button.

To begin a new search, click the down arrow in the Other Options field to 
obtain the drop-down menu of options. Click New Search from the Other 
Options menu and then click the Go button.

Technical Support

For technical assistance in searching the ULS for applications and licenses, contact the FCC 
Technical Support Hotline at (202) 414-1250. The FCC Technical Support Hotline generally 
will be available Monday through Friday, from 8 a.m. to 6 p.m. ET. All calls to the FCC 
Technical Support Hotline are .recorded.
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Attachment D

INSTRUCTIONS FOR MANUAL FILING OF ULS FORMS FOR 
PART 22 PAGING APPLICATIONS

FCC Forms 601, 603, and 604 may be filed manually. Manual filers are requested to 
submit a "clean" original application (i.e., without lines, markings, footnotes, tables, charts, 
etc.) which does not contain any information in spreadsheet format. Manual filers must mail 
or deliver the original application to:

Federal Communications Commission 
Common Carrier Land Mobile

P. O. Box 358130 
Pittsburgh, PA 15251-5130

Copies of FCC Forms 601, 603, and 604 can be obtained by calling the Commission's 
Forms Distribution Center at 1-800-418-3676 (outside Washington, D.C.) or 202-418-3676 (in 
the Washington area). Copies of these forms can also be obtained via the Internet at 
http://www.fcc.gov/formpage.html or by Fax-On-Demand at 202-418-2830.

All manually filed forms shall be submitted with a 3.5-inch floppy disk containing all 
attachments, and any other supporting documentation. Manual filers should review each 
exhibit file to ensure that the information contained in the exhibit is complete.

Failure to sign a manually-filed Form 601, 603, or 604 will result in dismissal of the 
application. Only original signatures will be accepted for manually-filed applications.

Applications affecting multiple licenses. Manual filers may submit a single Form 
601, 603, or 604 covering multiple licenses or call signs if all main form information (e.g., 
name and address, ownership, eligibility, and waiver requests) associated with the licenses or 
call signs is identical. Where main form information is identical for some licenses but 
different for others, the applicant may utilize this streamlined filing procedure only for those 
licenses that have identical filing information. For those licenses with unique information, a 
separate application must be submitted.
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Attachment E

ACCESSING THE FCC NETWORK 
USING WINDOWS 95

This attachment describes how to access the FCC Network from a system that is running the 
Microsoft Windows 95 operating system. This involves configuring dial-up network access 
and then performing the dial-up procedure.

Conventions

The instructions in this attachment use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer,
including buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, 
Auctions link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Licensee Name field, 
Applicant Information area of a screen).

bold italic Represents characters that you must type exactly as they appear in the
instructions. For example, if you are instructed to type http://www.fcc.gov, you 
should type all of the characters shown in bold italic exactly as they are 
printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, Esc).

Hardware and Software Requirements

Applicants who want to connect to the FCC Network using the Windows 95 Dial-Up 
Networking will need the following hardware and software.

Hardware Requirements

CPU: Intel 80486 or above

  RAM: 8 MB RAM (more recommended if you intend to open multiple applications)

  Hard Disk: 10 MB available disk space
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  Modem: v.32bis 14.4-kbps Hayes compatible modem

  Monitor: VGA or above

  Mouse or other pointing device 

Software Requirements

  Internet Web Browser software (Netscape Communicator 4.05 with JDK 1.1, Netscape 
Navigator 3.01, and Microsoft Internet Explorer 3.02 with the file upload patch were 
used during FCC internal testing)

  Microsoft Windows 95

Note: If you are running Windows in a networked environment, check with your local 
network administrator for any potential conflicts with the Windows 95 Dial-Up Networking. 
This usually includes any TCP/IP installed network protocol.

The Windows 95 Dial-Up Networking will establish a direct connection from your PC to the 
FCC Network. This point-to-point connection is not routed through the Internet.

Configuring Dial-Up Network Access

1. To start dial-up networking:

a. Click the Windows 95 Start button, 

b. Click the Programs option to display the Programs menu, 

c. Click the Accessories option to display the Accessories menu, 

d. From the Accessories menu, click Dial-Up Networking.

2. When the Dial-Up Networking window appears, double-click the Make New 
Connection icon.

3. The Make New Connection window appears. In the field entitled Type a name for the 
computer you are dialing, type ULS at FCC.

4. Click the down arrow at the right of the Select a modem field and select your modem 
from the menu of available modems.
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If your modem does not appear on this list, you must install your modem driver 
according to the modem manufacturer installation procedures, which are usually 
described in your modem's user manual.

5. Click the Configure button. Click the Options tab at the top of the Properties 
window.

6. In the Connection control area of the Options tab, verify that neither option is
selected. If either option is selected, cl'ick the check box at the left of the option to 
deselect it. Then click the OK button.

7. Click the Next button.

8. Type 800 in the Area Code field and 844-2784 in the Telephone Number field. Verify 
that the correct country is selected in the Country code field.

If not, click the down arrow at the right of the Country code field and select the 
appropriate country from the menu of available countries.

9. Click the Next button.

10. Click the Finish button. An icon titled ULS at FCC appears in the Dial-Up 
Networking window.

11. Verify that properties are configured correctly before attempting a dial-up session.
Position the mouse pointer on the ULS at FCC icon and click the right mouse button 
to display a menu. Select Properties from the menu.

12. Click the Server Type button at the bottom of the ULS at FCC screen.

13. In the Advanced Options area of the Server Type window, verify that only Enable 
software compression is selected.

If it is not selected, click the check box at the left of the option to select it. If either 
of the other options is selected, click the check box to deselect it.

14. In the Allowed Network Protocols area of the Server Type window, verify that only 
TCP/IP is selected.

If it is not selected, click the check box at the left of the option to select it. If either 
of the other options is selected, click the check box to deselect it.

15. Click OK on the Server Type window, then click OK on the Properties window.
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16. To configure the TCP/IP protocol:

a. Click the Windows 95 Start button.

b. Click the Settings option to display the Settings menu.

c. Click the Control Panel option to display the Control Panel.

d. Double-click the Network icon.

e. Highlight the TCP/IP protocol and click Properties.

  If multiple TCP/IP protocols are displayed, select TCP/IP ~> Dial-Up 
Adapter.

  If TCP/IP is not installed, click the Add button, then click Protocol and 
click Add. Select Microsoft from the list of Manufacturers, then select 
TCP/IP from the list of Network protocols. Click OK to add it, then 
highlight TCP/IP and click Properties.

f. Click the DNS Configuration tab.

g. Click Enable DNS.

h. If there is no Host, type bidder in the Host field.

i. Type 192.104.54.1 in the DNS Server Search order field and click the Add 
button.

j. Click OK on the TCP/IP Properties window, then click OK on the Network 
window.
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Dial-Up Procedure

1. If your PC is connected to a Local Area Network (LAN), perform the steps below 
before dialing into the FCC Network. Otherwise, proceed to step 2.

a. Start up your PC without logging into the network.

b. Click the Windows95 Start button and select Run.

c. Type winipcfg in the Run window and click on OK.

d. Click the Release All button to reset the IP address to "0.0.0.0."

2. If the Dial-Up Networking window is not currently open, do the following: 

a. Click the Windows 95 Start button, 

b. Click the Programs option to display the Programs menu, 

c. Click the Accessories option to display the Accessories menu, 

d. From the Accessories menu, click Dial-Up Networking. 

The Dial-Up Networking window appears.

3. Double-click the ULS at FCC icon in the Dial-Up Networking window.

4. Click the Connect button on the ULS at FCC window. Do not enter User name and 
Password.

The Connecting to ULS at FCC window appears, indicating the status of your 
connection as your modem dials into the system. This window must remain running 
during your dial-up session. You may minimize the window, if you wish.

5. Once the connection is established, open your web browser (Netscape or Internet 
Explorer).

6. In the Location field (Netscape 3.x), Netsite field (Netscape 4.x), or Address field 
(Internet Explorer) of the web browser screen, type the desired Universal Resource 
Locator (URL). Then press the ENTER key.

7. When you have finished, exit the web browser, then click the Disconnect button on 
the ULS at FCC window to end your dial-up session.
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Troubleshooting

Following are resolutions of problems you may encounter when accessing the FCC Network. 

Modem does not respond

1. Confirm that the correct modem driver is installed for your modem.

2. Confirm that all physical connections for the modem are present.

3. Confirm that the phone line is active by connecting the modem cable to a telephone.

Modem dials but does not connect

1. Confirm that the modem is dialing the correct number.

2. Confirm that the modem prefix (if any) is correct.

Modem dials and connects, but nothing appears when you enter the location in the web 
browser

1. Check the settings in your dial-up networking icon, particularly that the Primary DNS 
is 192.104.54.1 and that TCP/IP is the only selected protocol.

2. Confirm that your web browser is using no proxies.

3. It is recommended that you do not log into a TCP/IP Local Area Network (LAN). If 
you do log into a TCP/IP LAN, confirm that your LAN network IP address is being 
released. To do so, connect to the FCC Network using dial-up networking, then click 
the Start button in Windows95 and select Run. Type winipcfg and press OK. If 
your IP address does not begin with "192.104.", then your LAN IP address is not 
being released. Click the Release AH button, or consult you LAN administrator.

Technical Support

For technical assistance in accessing the FCC Network using Windows95, contact the FCC 
Technical Support Hotline at (202) 414-1250. This hotline is generally available Monday 
through Friday, from 8 a.m. to 6 p.m. ET. All calls to the FCC Technical Support Hotline 
are recorded.
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Attachment F

ACCESSING THE FCC NETWORK 
USING WINDOWS 3.1 OR 3.11

This attachment describes how to access the FCC Network from a system that is running the 
Microsoft Windows 3.1 or Windows for Workgroups 3.11 operating system. This involves 
using the FCC-supplied Point-to-Point Protocol (PPP) Dialer.

This attachment summarizes the hardware and software required for the PPP Dialer, then 
describes the procedures for performing the following tasks:

  Downloading the Dialer files from the Internet or the FCC Bulletin Board
  Extracting the Dialer from the downloaded files
  Installing the Dialer application 

Configuring PPP
  Establishing a PPP connection

The attachment also describes how to troubleshoot and uninstall the PPP Dialer application, 
and tells how to get help from the FCC.

Conventions

The instructions in this attachment use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer,
including buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, 
Auctions link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Licensee Name field, 
Applicant Information area of a screen).

bold italic Represents characters that you must type exactly as they appear in the
instructions. For example, if you are instructed to type http://www.fcc.gov, you 
should type all of the characters shown in bold italic exactly as they are 
printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, Esc).
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Hardware and Software Requirements

Applicants who want to connect to the FCC Network using the FCC PPP Dialer will need the 
following hardware and software.

Hardware Requirements

CPU: Intel 80486 or above

  RAM: 8 MB RAM (more recommended if you intend to open multiple applications)

  Hard Disk: 10 MB available disk space

  Modem: v.32bis 14.4-kbps Hayes compatible modem

  Monitor: VGA or above

  Mouse or other pointing device 

Software Requirements

  Internet Web Browser software (Netscape Communicator 4.05 with JDK 1.1, Netscape 
Navigator 3.01, and Microsoft Internet Explorer 3.02 with the file upload patch were 
used during FCC internal testing)

  Microsoft Windows 3.1 or Microsoft Windows for Workgroups 3.11

Note: If you are running Windows in a networked environment, check with your local 
network administrator for any potential conflicts with the FCC PPP Dialer. This usually 
includes any TCP/IP installed network protocol.

The FCC PPP Dialer will establish a point-to-point connection from your PC to the FCC 
Network. This point-to-point connection is not routed through the Internet.

Downloading the Dialer Software

Applicants who wish to use the FCC PPP Dialer must first download the dialer software from 
either the Internet or the FCC Bulletin Board System. Applicants must download the 
following compressed files to install the software:

fccdiall.exe 
fccdial2.exe 
fccdial3.exe
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Download Method 1: Internet Access

You may use your Internet browser to download the compressed files from www.fcc.gov or 
wtbwww01.fcc.gov, as described in the following sections.

• Downloading from www.fcc.gov

1. Connect to your Internet Service Provider and start your web browser.

2. In the Location (Netscape) or Address (Internet Explorer) field of the web
browser screen, enter the following location: http://www.fcc.gov. Then press 
the ENTER key.

3. Click the Electronic Filing link.

4. Click Universal Licensing System at the bottom of the screen.

5. Click the FCC PPP Dialer button, located on the left side of the page.

6. Scroll down to the Download the Dialer section of the page. Download the 
following files by clicking their respective filename links: fccdiall.exe, 
fccdial2.exe, fccdial3.exe

• Downloading from wtbwww01.fcc.gov

1. Connect to your Internet Service Provider and start your web browser.

2. In the Location (Netscape) or Address (Internet Explorer) field of the web
browser screen, enter the following location: http://wtbwwwOLfcc.gov. Then 
press the ENTER key.

3. Click the Dialer link.

4. Download the following files by clicking each of the corresponding icons: 
fccdiall.exe, fccdial2.exe, fccdial3.exe

Download Method 2: Dial-In Access to the FCC Auction Bulletin Board System (BBS)

The FCC Auction Bulletin Board System (BBS) provides dial-in access for the FCC PPP 
Dialer. To access the FCC Auction BBS, use a communications package that can handle at 
least Xmodem protocol (such as PcAnyWhere, Procomm, or Microsoft Terminal in Windows 
3.x) to dial in to (202) 682-5851. Use the settings of 8 data bits, no parity, and 1 stop bit (8,N,1).
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Once your computer is connected to the Auction BBS. do the following:

1. To create an account:

a. Enter your first name.

b. Enter your last name.

c. When asked whether you want to create an account, enter Y.

d. When prompted, enter a password.

The password can be from four to ten characters long, where the characters can 
be either letters or numbers.

e. To confirm the password, enter it again.

f. When prompted for contact information, enter your voice phone number, 
including area code.

For example, you might enter 202-555-1234. 

g. Enter your company name.

2. On the Welcome screen, enter C for Continue. (You may also enter c, the program 
accepts either uppercase or lowercase.)

Since C is the default (automatic) selection, you can also just press ENTER to continue.

3. When asked whether you want to view the bulletin menu, enter Y for Yes. Then press 
ENTER to obtain the FCC Auction BBS Main Menu.

4. Enter A (for Auction Menu) to obtain the Auction Library Menu.

The top options on this menu provide a range of numbers to represent the available 
auctions.

5. To select Dialer, enter D.

The list of available files appears. These files are sorted by date, with the most recent 
files at the beginning of the list.
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6. To scroll downward to the next screen of file names, either press ENTER or enter C for 
Continue. To scroll upward to the preceding screen of file names, enter P for 
Previous.

Note that on each screen, file names are numbered separately, starting with 1.

7. To select one or more files for downloading or viewing, mark the files you want. The 
program marks a file by preceding its name with an asterisk (*).

You can do the following:

  To mark an individual file, enter its line number.

  To mark a range of files, enter M (for Mark) and then enter the range of files in 
response to the prompt.

For example, to mark files 1 through 3, enter 1-3 at the prompt.

  To unmark a file, enter its number again.

You can also use Mark to unmark a range of files.

Use any of these techniques to mark the following files: fccdiall.exe, fccdial2.exe, 
fccdiaI3.exe

8. When you have finished marking files, download them as follows: 

a. Enter D for Download.

The program displays a list that summarizes the download operation. The Time 
column lists the download time for each file; the Total Time column lists a 
running total of the download times.

b. Enter D to proceed.

c. Select the file transfer protocol that has been specified in your terminal emulation 
software (e.g., Xmodem or Zmodem).

When the download operation has finished, the list of files reappears.

9. Enter X to leave the BBS.
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Extracting the FCC PPP Dialer

The FCC PPP Dialer files are downloaded in a self-extracting, compressed file format. When 
you have downloaded the compressed files, you must extract the FCC PPP Dialer from each 
file.

To extract the software, start File Manager in the Main Program group, open the file folder 
where you downloaded the files, and double-click each file (fccdiall.exe, fccdiaI2.exe, 
fccdial3.exe). A message will appear listing the default directory to which the software will 
extract. If this directory does not exist, it will be created automatically. Click Unzip to 
begin extracting the software from the compressed files.

When the extraction is complete, a message will appear listing the number of files that were 
unzipped. Click OK to automatically start the setup program.

Installing the FCC PPP Dialer

After you extract the software from all of the compressed files, go to File Manager, locate the 
directory to which you extracted the software, and double-click setup.exe.

To begin, the setup program shows a screen listing the default directory to which the software 
will install. Click the Install button, then click OK to install to the specified directory. If 
the directory does not exist, the setup program will create it automatically.

When the installation is complete, a message may appear asking you to restart Windows so 
that the changes made by the installation can take effect. Click Restart to restart Windows 
or click Stay Here to restart at a later time. Do not use the FCC PPP Dialer until you have 
restarted Windows.

You will now have a new Program Manager group called FCC PPP Dialer with icons 
labeled Configure PPP, PPP Dialer, and Uninstall.

Running the Configure PPP Program

Before establishing a PPP connection, you must run the Configure PPP program. If desired, 
you may also adjust the configuration settings.

To start the Configure PPP program:

1. Double-click the Configure PPP icon. The communications setup window appears.

2. From the Modem menu, select the COM port to which your modem is connected.
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3. From the Speed menu, select the maximum DTE rate of your modem.

For 14.4-kbps and 28.8-kbps modems, you can generally select a speed of 38400 or 
57600.

4. In most cases, carrier detect should not be checked and flow control should be
checked. If you experience problems getting the modem to respond, experimenting 
with these settings may help.

5. The DNS should be set to 192.104.54.1.

The remainder of the screen has default values which should provide optimal 
performance.

6. Click the Script button to bring up the Script Setup screen. This screen gives you the 
ability to issue specific commands to the modem.

7. Click the down arrow in the Selected Modem field and choose the entry from the list 
that most closely matches the modem installed on your PC.

If your modem does not appear in the list, select a generic modem string by entering 
either ATZ (for 14.4-kbps modems) or AT&F (for 28.8-kbps modems) in the Reset 
Modem String box.

8. It may be necessary to change the command in the Modem Dial Prefix field to 
accommodate how you make calls.

For example:

Add a 1 before dialing the 800 number: ATDT1
Dialing prefix of 9 used, add a 1 before dialing the 800 number: ATDT91
Turn off call waiting, add a 1 before dialing the 800 number: ATDT*70,1

9. If you use a dialing suffix, enter it in the Dial Suffix field.

10. The default settings provided in Configure PPP should be compatible with most 
systems. If you experience problems connecting to the FCC Network, refer to the 
Troubleshooting section for possible solutions.

11. When you have finished using the Configure PPP program, click the OK button. You 
may now start the FCC PPP Dialer.
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Establishing a PPP Connection

Once you have run the Configure PPP program, you can establish a PPP connection. If your 
PC is connected to a TCP/IP Local Area Network (LAN), disconnect your network 
connection before establishing a PPP connection. You can disconnect your network 
connection by restarting your PC without logging into the network.

1. To start the PPP Dialer, double-click the PPP Dialer icon in the FCC PPP Dialer 
program group.

The dialer will attempt to dial the toll-free 800 number automatically.

2. When the PPP Dialer establishes a connection, you will gain access to the PPP Dial 
Up screen. You may switch to the PPP Dial Up screen by pressing ClRL+Esc and 
double-clicking PPP Dial Up in the Task List.

The screen will display the current status of the PPP connection.

3. To refresh the status of the PPP connection, select the Refresh Status option from the 
Dial menu.

4. Select the Minimize option from the Window menu to minimize the PPP Dial Up 
screen.

5. To test the status of the PPP connection, select the Test Connection from the Dial 
menu. This option allows you to ping the FCC Network. The ping process sends a 
signal to the FCC Network; if the signal returns, you have established a good 
connection.

The Hostname box will show 192.104.54.1.

6. From the Number menu, choose the number of pings you wish to send (one,
continuous, or a user-specified number). From the Specifications menu, you can 
customize the type of request (e.g., icmp echo request), the interval between pings, and 
the timeout setting; the default settings should suffice.

If you change any of the settings and would like to save them, select the Save option 
from the File menu.

7. Click the Start button.

The status and packets boxes will display information concerning whether the pings 
were returned.
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8. If necessary, click the Stop button, to end the ping process. Click the Exit button to 
exit the Ping program.

Disconnecting the PPP Connection

To disconnect from the FCC Network, switch to the PPP Dial Up screen and select the 
Disconnect option from the Dial menu.

Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating 
them.

Modem does not respond

1. Check the COM port setting.

2. Make sure that you have selected the appropriate modem in the Selected Modem list.

If your modem does not appear in the list, select a generic modem string by entering 
either ATZ (for 14.4-kbps modems) or AT&F (for 28.8-kbps modems) in the Reset 
Modem String field.

3. Check your modem for IRQ conflicts.

4. Check the physical connections.

5. Change Carrier Detect.

6. Change Flow Control.

Modem connects but does not return an IP address

1. Check that you have selected the appropriate modem in the Selected Modem list.

2. Verify the DNS is set to 192.104.54.1.

3. Verify the MRU and MTU are set to 1500.

4. Turn off VJ Compression.
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5. Change timeout to 15.

This is found on the Script Setup screen in Configure PPP.

6. Check your modem for IRQ conflicts.

7. Unload network drivers.

SQLSERVER errors

1. Turn off VJ Compression.

2. Unload network drivers.

3. Check for the existence of multiple winsock.dll files on your PC.

4. Test the PPP connection with the Ping program.

Errors may be caused by having multiple winsock.dll files on your PC. To search for 
conflicting winsock.dll files, start File Manager, open the directory for the root of the hard 
drive you want to search (usually c:\) and select the Search option from the File menu. In the 
search for: box, enter winsock.dll. Verify that the select all subdirectories option is selected, 
then click OK.

Make sure that any other winsock files are not in your path. To check this, go to the DOS 
prompt and type path. If any directory containing another winsock.dll file appears in the 
path, do either of the following:

  Edit the autoexec.bat file to remove the reference to that directory, then save and 
reboot the PC. If you need to use the other PPP software package, reinsert the 
appropriate directory reference, save, and reboot.

  Temporarily rename the conflicting winsock.

UninstalHng the FCC PPP Dialer Application

To uninstall the FCC PPP Dialer, double-click the Uninstall icon in the FCC PPP Dialer 
program group. Click Start to uninstall the software.
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Technical Support

For technical assistance in installing or using the FCC PPP Dialer, contact the FCC Technical 
Support Hotline at (202) 414-1250. This hotline is generally available Monday through 
Friday, from 8 a.m. to 6 p.m. ET. All calls to the FCC Technical Support Hotline are 
recorded.
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